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What to Know About Smart TVs and Your Privacy
by  Josh Centers

Most new TVs on the market are so-called “smart TVs,” which incorporate software platforms that 
can run apps like Netflix without requiring an external device like an Apple TV. These 
network-connected smart TVs offer some convenience — it’s handy having a Netflix button on your TV 
remote. But with such network-enabled capabilities come the inevitable privacy concerns.

TV maker Vizio recently agreed to a $3.7 million settlement with the Federal Trade Commission 
over its data-gathering practices. Vizio has also agreed to “stop unauthorized tracking, to prominently 
disclose its TV viewing collection practices, and to get consumers’ express consent before collecting and 
sharing viewing information.”

The fact that Vizio was tracking its customers was nothing new, but the scope of that tracking may 
surprise you:

Starting in 2014, Vizio made TVs that automatically tracked what consumers were watching and 
transmitted that data back to its servers. Vizio even retrofitted older models by installing its tracking 
software remotely. All of this, the FTC and AG allege, was done without clearly telling consumers or 
getting their consent.

What did Vizio know about what was going on in the privacy of consumers’ homes? On a 
second-by-second basis, Vizio collected a selection of pixels on the screen that it matched to a database of 
TV, movie, and commercial content. What’s more, Vizio identified viewing data from cable or 
broadband service providers, set-top boxes, streaming devices, DVD players, and over-the-air broadcasts. 
Add it all up and Vizio captured as many as 100 billion data points each day from millions of TVs.

Vizio then turned that mountain of data into cash by selling consumers’ viewing histories to advertisers 
and others. And let’s be clear: We’re not talking about summary information about national viewing 
trends. According to the complaint, Vizio got personal. The company provided consumers’ IP addresses 
to data aggregators, who then matched the address with an individual consumer or household. Vizio’s 
contracts with third parties prohibited the re-identification of consumers and households by name, but 
allowed a host of other personal details – for example, sex, age, income, marital status, household size, 
education, and home ownership. And Vizio permitted these companies to track and target its consumers 
across devices.

Vizio isn’t alone. Our TidBITS Talk discussion list batted around a two-year-old story about 
Samsung warning customers to not discuss sensitive information in front of their TVs because the 
conversation could be recorded and sent to a third party.

Is this Orwell’s 1984, in which Big Brother installs TV sets in every home to spy on the populace? No, 
but it’s closer than may be comfortable.

First, no one is forcing these TV sets on consumers. There are still some “dumb TVs” on store shelves, 
though they’re in the minority. Second, a certain amount of viewer tracking isn’t necessarily bad. Netflix, 
for instance, picks which shows to license for streaming based on viewer metrics. However, some other 
companies, like Vizio, are gathering far more user data than just viewing habits, and they’re not using that 
data for viewer benefit, but instead selling access to the data to generate additional profits.

One might argue that selling access to viewer data, as Vizio did, helped keep TV prices low. But TV 
prices were pretty low already, and, in any case, the FTC doesn’t seem to agree with that reasoning.

If you already own a smart TV and are concerned by these patterns, you could take the Ron Swanson 
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SIG NEWS

The Saturday SMMUG Special Interest Group 
(SIG) will meet from 10:00 AM to 12:00 Noon, 
Saturday, March 11, 2016, in the Fire Station 18’s 
meeting room at: 6830 Hadler View (a map is 
located at the end of this NL). The meeting will be 
divided in to two parts.

The First part starting at 10:00 will focus on iOS, 
helping everyone become both comfortable and 
proficient with their iPhone, iPad, and iPod 
mobile devices. Starting at 11:00 we will focus on 
the Apple’s iCloud.

All are invited, but new users are especially 
encouraged to attend this free meeting. Bring your 
tips and tricks, questions and suggestions. 

For more information about Special Interest 
Groups (SIGs), go to the SMMUG website.

Scan this QR code to be taken to our 
SMMUG web site

ADVERTISING
You can advertise your business or service 
through the Silicon Summit.

RATES 
Per inch   $10
Quarter page   $15 
Half page   $25 
Full page   $50 
Insert                  $15

A 10% discount is applied for ads that 
run two or more months, except for 

inserts.

Sponsor ing Membersh ips a re a l so 
available to merchants who want to see 
their business name and address listed on 
the front page. Sponsoring Memberships 
are $100 for one year.

MEETING DATES
 

Our regular monthly meetings are on the second 
Monday of every month. Upcoming meeting 
dates are as follows:

 
March 13, 2017  
April 10, 2017  
May 8, 2017  

June 12, 2017  
July 10, 2017  

August 14, 2017  
September 11, 2017  

October 9, 2017  
November 13, 2017  
December 11, 2017

                                                                              
MISSED AN ISSUE?

You can find the previous issues of the 
Silicon Summit posted in PDF format at 
the SMMUG website.

THIS MONTH AT SMMUG

March 13, 2016
6:00 Q&A Session
6:45 Networking Break
7:00 Five Board members will each tell us 

about their favorite Apps.
8:00 Adjourn
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Announcements

Door Prizes For The March Meeting:
Akvis Sketch Deluxe (art program)
Printer
Car charger
Wireless mouse
USB power bank
iTunes card 

Support SMMUG by making your purchases through Amazon Smile!
According to Amazon: “When you shop at smile.amazon.com, 
Amazon donates to your favorite charitable organization. About 
AmazonSmile”

According to Skip M. (who added our club to the Amazon 
Smile list): this is how .5% of all you purchases can be donated to 
SMMUG: 

• Use this URL every time you log into Amazon: 
smile.amazon.com

• Next, type in Silicon Mountain, and scroll down the list 
until you see SMMUG

• Check the box and .5% of all your purchases will go to the 
Silicon Mountain Macintosh Users Group

Club News

Special Offer – Disk Drill PRO: 30% Discount
Special Offer – Teams ID, a Password Manager for Teams: 33% 
Discount
Special Offer – Eltima Software: Up to 60% Off OS X Apps
Special Offer – EverWeb by RAGE Software: 50% Discount
Special Offer – Take Control Books: 30% Discount on all eBooks
Special Offer – Opus ][ Complete Collection: 25% Discount
Special Offer – Joe On Tech Guides: 20% Discount on All Books
Special Offer – AgileBits 1Password 5 and more: 25% Discount

Special Offer – Eltima Software multimedia products: 20%                         
Discount
Special Offer – From the makers of TechTool Pro: 20% Discount
Special Offer – Noteboom Tutorials: 33% Off Annual Memberships
Special Offer – OReilly: 40-50% Discount 
Special Offer – Prosoft Engineering: 25% Off
Special Offer – Que Publishing Products: 35-45% Discount
Special Offer – SlideShark iPad PowerPoint Viewer: Free App plus Offer

SMMUG members, check the Members Only Section of our website to get the login password to 
access these User Group Only deals:

https://smile.amazon.com/about/?ref=sxts_snpl_3_1_2447752202&qid=1489287672&pf_rd_m=ATVPDKIKX0DER&pf_rd_p=2447752202&pf_rd_r=VPDHQB26NXPHS4YPRJ28&pd_rd_wg=VYuLU&pf_rd_s=desktop-signpost&pf_rd_t=301&pd_rd_w=f01jS&pf_rd_i=amazon+smile&pd_rd_r=H1TPMYAPCEFFSA012G50
https://smile.amazon.com/about/?ref=sxts_snpl_3_1_2447752202&qid=1489287672&pf_rd_m=ATVPDKIKX0DER&pf_rd_p=2447752202&pf_rd_r=VPDHQB26NXPHS4YPRJ28&pd_rd_wg=VYuLU&pf_rd_s=desktop-signpost&pf_rd_t=301&pd_rd_w=f01jS&pf_rd_i=amazon+smile&pd_rd_r=H1TPMYAPCEFFSA012G50
https://smile.amazon.com/about/?ref=sxts_snpl_3_1_2447752202&qid=1489287672&pf_rd_m=ATVPDKIKX0DER&pf_rd_p=2447752202&pf_rd_r=VPDHQB26NXPHS4YPRJ28&pd_rd_wg=VYuLU&pf_rd_s=desktop-signpost&pf_rd_t=301&pd_rd_w=f01jS&pf_rd_i=amazon+smile&pd_rd_r=H1TPMYAPCEFFSA012G50
https://smile.amazon.com/about/?ref=sxts_snpl_3_1_2447752202&qid=1489287672&pf_rd_m=ATVPDKIKX0DER&pf_rd_p=2447752202&pf_rd_r=VPDHQB26NXPHS4YPRJ28&pd_rd_wg=VYuLU&pf_rd_s=desktop-signpost&pf_rd_t=301&pd_rd_w=f01jS&pf_rd_i=amazon+smile&pd_rd_r=H1TPMYAPCEFFSA012G50
http://smile.amazon.com/
http://smile.amazon.com/
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approach and toss it in the dumpster, but that’s not necessary.

For a simpler solution, just don’t connect your TV to the Internet. If you want to use Netflix and other apps, get an Apple TV, which has the best 
privacy policy in the business (as well as — shameless plug — the best independent manual in the business, my “Take Control of Apple TV”).

If you would still like to take advantage of your TV’s apps without sacrificing privacy, Jake Swearingen of New York Magazine has compiled an 
outstanding guide to maximizing privacy on the most popular TV platforms. His guide notes that Vizio TV sets going forward will have their 
“Smart Interactivity” feature turned off by default. Given the size of the FTC settlement, I imagine that most other manufacturers will take similar 
steps.

Bear in mind that it’s not just smart TVs that could be listening in. If you own an Amazon Echo or a Google Home, you have an always-on 
listening device in your house. And 
if you have Hey Siri enabled on 
your iOS devices, they could also 
listen in. (On iOS devices you can 
prevent such behavior: go to 
Settings > Siri and disable Allow 
“Hey Siri”.)

This isn’t merely hypothetical. 
Law enforcement officials are trying 
to compel Amazon to hand over 
recordings from an Amazon Echo 
for evidence in a murder case. In yet 
another installment of “The Future 
Is Weird,” Amazon is trying to 
protect customer data against the 
government by arguing that Alexa, 
the AI assistant that powers the 
Echo, has First Amendment 
protections.

For that matter, you can assume 
that any networked device with a 
camera and/or microphone could, 
at least in theory, be used to spy on 
you. Don’t feel paranoid if you have 
an urge to slap tape over your 
webcam — Facebook CEO Mark 
Zuckerberg does the same thing. 
(Despite Facebook’s ravening desire 
to know ever more about its users 
and byzantine privacy controls, 
Zuckerberg seems to take his own 
privacy very seriously.)

We live in interesting times, 
times in which privacy-conscious 
people need to be extra vigilant. 
However, by taking a few simple 
precautions, you can maintain some 
level of control over how much data 
you share.

Can’t wait for the next newsletter to see what the guys and gals at Joy of Tech are up to? Then simply go on over to their 
website and see past and current cartoons and other things

http://www.youtube.com/watch?v=ABY3GLf7wU4
http://www.youtube.com/watch?v=ABY3GLf7wU4
http://tid.bl.it/tco-apple-tv-tidbits
http://tid.bl.it/tco-apple-tv-tidbits
http://nymag.com/selectall/2017/02/how-to-turn-off-smart-tv-tracking.html
http://nymag.com/selectall/2017/02/how-to-turn-off-smart-tv-tracking.html
http://nymag.com/selectall/2017/02/how-to-turn-off-smart-tv-tracking.html
http://nymag.com/selectall/2017/02/how-to-turn-off-smart-tv-tracking.html
http://www.forbes.com/sites/thomasbrewster/2017/02/23/amazon-echo-alexa-murder-trial-first-amendment-rights/
http://www.forbes.com/sites/thomasbrewster/2017/02/23/amazon-echo-alexa-murder-trial-first-amendment-rights/
http://www.forbes.com/sites/thomasbrewster/2017/02/23/amazon-echo-alexa-murder-trial-first-amendment-rights/
http://www.forbes.com/sites/thomasbrewster/2017/02/23/amazon-echo-alexa-murder-trial-first-amendment-rights/
https://www.theguardian.com/technology/2016/jun/22/mark-zuckerberg-tape-webcam-microphone-facebook
https://www.theguardian.com/technology/2016/jun/22/mark-zuckerberg-tape-webcam-microphone-facebook
http://www.joyoftech.com/joyoftech/
http://www.joyoftech.com/joyoftech/
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DOOR PRIZE WINNERS

For The February 2017 Meeting
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OS X Hidden Treasures
Dominate the Dock

by Josh Centers
The Dock has been a core aspect of the Mac experience since the earliest days of Mac OS X. In fact, the Dock actually predates Mac OS X, since it 

was also prominent in NeXTSTEP. It displays open applications, offers a quick way to launch favorite apps, and holds shortcuts for documents and 
folders.

You’ve probably used the Dock so often and for so long that you don’t think about it. We’ll explain everything the Dock does, from the basics to 
tweaky capabilities that may be new to you.

Today’s Dock is split into three sections, marked by dividing lines: Handoff, apps, and a third area that contains documents, folders, and the 
Trash.

Using Handoff in the Dock -- Let’s dispense with Handoff first, since it’s a one-trick pony and not something that many Mac users who we 
know use.

The Handoff section contains only a single icon and appears only if your Mac is 
receiving a Handoff signal from another iOS device or Mac.

For instance, if you open a Web page in Safari on a compatible iPhone, you might see 
a Safari icon at the left or top of your Dock. Click that icon to open the iPhone’s Web 
page in Safari on your Mac. You might also see icons for Mail, Reminders, or other Handoff-savvy apps.

For more on Handoff, check out Scholle McFarland’s “Sierra: A Take Control Crash Course,” which has an entire chapter about it.
Opening and Switching to Apps via the Dock -- More commonly, the first section of your Dock contains apps that are either currently open or 

that you have saved to the Dock for quick access. Clicking an app either opens it or switches to it. In macOS 10.12 Sierra, open apps are denoted by 
a small dot underneath the icon (or on its side, if you’ve moved your Dock to the left or right edge of the screen). In earlier versions, the Dock gave 
open apps other markings, such as triangles.

If you don’t recognize an icon in the Dock, hover your mouse pointer over the icon and a tooltip appears showing the app name. This also works 
for documents and folders, where it’s even more useful, since their icons are often somewhat generic.

When your goal is to end up with a particular document open in an app, a more efficient way to open or switch to that app is to drop a 
compatible file onto it. For example, if you drag a text file from the Finder and drop it on TextEdit’s Dock icon, TextEdit opens with that 
document.

If you see an app icon with a question mark, it means that the source file has been deleted, thus breaking the Dock’s alias. You’ll need to figure out 
what happened to it in the Finder.

Although it’s hard to imagine anyone bothering to do this, you can also open an app via its contextual menu. Access it by clicking and holding, 
Control-clicking, right-clicking, or force-touching the Dock icon, and then choose Open.

Other App Actions from the Dock -- Although the contextual menu is a silly way to open an app, it provides access to a wide variety of more 
useful actions that you can perform on apps:
• Quit an app: To quit an open app from the Dock, choose Quit from the contextual menu. Unless you’ve set that app to stay in the Dock, its 

icon disappears from the Dock when it quits. Pressing Command-Q in the app is easier.
• Force Quit an app: If an app is frozen and won’t quit via the usual method, open the 

app’s contextual menu and hold Option to turn Quit into Force Quit. Remember that 
Force Quit closes the app instantly, without prompting to save your work. We’ve found 
this more successful than the dialog you get by choosing Force Quit from the Apple 
menu.

• Relaunch Finder: You can’t quit or force quit the Finder, but you can relaunch it if it’s 
giving you trouble. To do so, hold Option as you invoke the contextual menu and choose 
Relaunch. Note that Relaunch won’t appear if you press Option after opening the 
contextual menu, as it does for Force Quit.

• Keep an app in the Dock: If you’d like to be able to open a currently running app from 
the Dock at a future time, choose Options > Keep in Dock from the contextual menu. A 
check mark appears next to Keep in Dock.
Another way to keep a running app in the Dock is to move it anywhere within the Dock. 

http://tid.bl.it/sierra-crash-course-tidbits
http://tid.bl.it/sierra-crash-course-tidbits
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Click, drag, and drop, and the app will stay in the Dock.
Of course, you can also just drag any app icon from the Finder to the Dock to add it, whether or not it’s running.

• Remove an app from the Dock: The most intuitive way to remove an app from the Dock is to drag it far enough out of the Dock for the 
Remove popup to appear and then release. If you change your mind mid-drag, either drag the app back to the Dock or press the Escape key.
To remove an app from the Dock via the contextual menu, choose Options > Remove from Dock if the app is closed or Options > Keep in Dock 
if it’s open. (Remember, a check mark appears next to Keep in Dock if that option is engaged.)
Note that removing an app from the Dock doesn’t affect the actual app, since the Dock icon is merely an alias. If you delete an app from the 
Dock, you can still find it in the Finder, usually in the Applications folder.

• Hide an app: If you don’t want to quit an app, but instead merely get it out of your way, you can hide its windows by choosing Hide from the 
contextual menu. Click the app’s Dock icon again to reveal the hidden app.
An easier approach is to Option-click the Desktop, any other app window, or any icon in the Dock. Or just press Command-H while the app is in 
the foreground. 
Of course, you can also minimize a single app window to the Dock, as explained below.

• Hide all but the selected app: To focus on a single app, you can hide all other app windows. Open the app’s contextual menu and press Option 
to turn Hide into Hide Others.
Again, a quicker way to Hide Others is to Command-Option-click the app’s Dock icon or press Command-Option-H while the app is in the 
foreground.

• Show all app windows: To invoke Mission Control in Application Windows view, choose Show All Windows from the contextual menu. Click 
a window to bring it to the front. 
Another way to invoke Mission Control is to force touch the app’s Dock icon, if you have a sufficiently capable trackpad.

• Open an app at login: From the contextual menu, choose Options > Open at Login. A check mark appears next to Open at Login. To stop the 
app from opening at login, choose the same option again, and the check mark should disappear.
You can verify that this has happened by looking in System Preferences > Users & Groups > Login Items.

• Show an app in the Finder: Maybe you want to delete an app that’s in the Dock, or maybe you forgot where it’s stored. To reveal its actual 
location, open its contextual menu and choose Options > Show App in Finder.

• Assign app windows to a desktop: If you use multiple Mission Control desktops, it can be 
helpful to tie an app’s windows to a specific one. Under Options in an app’s contextual menu, 
you’ll see a Desktops header with a list of your desktops. Choosing a desktop moves that app’s 
windows to that desktop and keeps them there.
• App-specific commands: Apps can add their own commands to their contextual Dock 
menus. So, for instance, Mail lists open windows in its menu and offers commands for Get 
New Mail, New Viewer Window, and Compose New Message. Every app with custom 
commands will be different, so be sure to check your most-used apps.
Docs and Minimized Windows in the Dock -- The Dock can also hold documents and 

minimized windows. To add a document, or, again, an alias to that document, to the Dock, drag 
it to the right side of the Dock, to the right of the divider. If your Dock is vertical, drop at the 
bottom, below the divider.

Click a document icon in the Dock to open it. The contextual menu offers a few extra options, but not many: Remove from Dock, Open at 
Login, and Show in Finder, the last of which is more useful than it is with apps.

You can even add Web shortcuts to the Dock. In Safari, click in the URL bar to reveal the full URL. Click and drag the favicon at the left of the 
URL bar down to the document section of the Dock to add a bookmark to that Web page to the Dock. This technique also works in Google 
Chrome and Firefox.

When you minimize a window, either by clicking the yellow minimize icon or choosing Window > Minimize, it shrinks into the same section of 
the Dock. Click a minimized window to expand it again. The contextual menu doesn’t offer any options for minimized windows other than 
opening them, and opening a minimized window is the only way to remove it from the Dock for good. Note that minimized windows look just like 
thumbnails of their windows with their app’s icon as a small badge — the badge differentiates a minimized window from a document icon.

Working with Folders in the Dock -- Just as with documents, you can drag and drop folders to the right or bottom of the Dock. Clicking the 
folder in the Dock reveals a preview of the folder’s contents, but if you Command-click the folder, it instead opens in the Finder. You can also drag 
Finder items into a Dock folder to move them into that folder.

The Dock’s contextual menu for folders offers several options that let you customize how folders display in the Dock. First, you can set how the 
Dock preview sorts documents in the folder: by Name, Date Added, Date Modified, Date Created, or Kind.

You can also choose whether the folder appears in the Dock as a folder or a stack. Displaying it as a folder uses the same blue folder icon as in the 
Finder, while the stack shows a stacked preview of the files in the folder. This is purely an aesthetic choice, although the contents of some folders may 
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lend themselves to one approach or the other.

More interesting is how you can customize the folder preview. Fan, which is an option only when the Dock is positioned at the bottom of the 
screen, shows the enclosed files in a curved stack with icon previews. Grid shows preview icons for the folder’s contents in a rectangle. List shows just 
a pop-up menu of file and folder names, and Automatic tries to choose which display to use based on how many items are in the folder.

Grid view is the most useful in general. It clearly shows all the files and folders in a format 
that’s easy to scan. You can also scroll through the files to see everything. Fan view shows too 
few items and is just strange, while List view is a bit too bare bones.

The Grid and List views also let you navigate into nested folders. Click a folder to reveal its 
contents in the Grid view; you can click the back button to go up one level. In List view, you 
can access nested folders via a hierarchical menu.

The main thing you’ll do in any of these views is open files and folders by clicking or 
selecting them. However, in Grid view, you can also drag files and folders from the preview to 
the Desktop, other folders, apps, and more.

Working with Trash in the Dock -- Since the advent of Mac OS X, the Trash has lived in 
the Dock. It’s simple to use: click the Trash icon to open the Trash in the Finder, drag items 
to the Trash to delete them, and to empty the Trash, Control-click its icon and choose Empty 
Trash. Obviously, there are other ways of deleting files (we like pressing Command-Delete) 
and emptying the Trash (choose Finder > Empty Trash).

If you have an external drive that you want to dismount, or some form of 
removable storage (like a DVD) that you want to eject, start dragging it and the 
Trash icon becomes an Eject icon. It’s not intuitive, but matches the classic Mac 
behavior of dragging floppies to the Trash to eject them. You can also select the 
drive and choose File > Eject or press Command-E.

Customizing the Dock’s Look and Feel -- There are a handful of ways you 
can customize how the Dock as a whole looks and works. To get started, open 
System Preferences > Dock. You can also access the Dock preference pane by 
Control-clicking the divider between the app and document sections of the 
Dock and choosing Dock Preferences (when you mouse over the divider, the 
mouse pointer turns into a double-ended arrow).

The first setting is the size slider. If you have the screen real estate, larger is usually 
better. At its largest size, the Dock automatically scales to the size of the screen 
based on how many icons it contains.

You can also resize the Dock directly. Move the mouse pointer over the divider 
between the app and document sections until it becomes a double-ended arrow. 
Click and drag to adjust the Dock size.

Next, you can choose to turn on magnification and set how large you want the 
magnified icons to be. When magnification is enabled, Dock icons enlarge as you 
mouse over them. It’s a cool effect that makes it easy to see icons that would 

otherwise be small.
  The third option lets you change the position of the Dock — 
it’s perhaps the most important setting. By default, the Dock is 
displayed horizontally on the bottom of the screen. However, 
that’s almost always an inefficient use of space since nearly all 
screens are wider than they are tall, whereas most document 
windows are taller than they are wide. That leaves extra space 
on the sides of your screen, so it makes sense to pin your Dock 
vertically on the right or left.
 Which side is better? Adam Engst prefers the right side because 
he uses two monitors, and positioning the Dock on the right 
side of the right-hand monitor prevents it from showing up 
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awkwardly in the middle of the Desktop. Apple also offers a bit of guidance here. On the iPhone Plus models, when the phone is in landscape 
orientation, the iOS Dock appears on the right side of the screen. That makes sense in macOS too, since it keeps the Trash in the lower right of the 
screen.

The remaining Dock preferences provide mostly cosmetic tweaks:
• Minimize Windows Using: You can choose to minimize windows 

using either the Genie or Scale effect. It’s purely a cosmetic choice — 
try both and see which you prefer. Here’s an eye-candy tip: hold Shift 
as you minimize a window to see it sucked into the Dock in slow 
motion. Similarly, holding Shift as you click a minimized window (or 
folder!) expands it slowly.

• Prefer Tabs When Opening Documents: Why is this setting associated with Dock preferences? It makes no sense! The default is Always, but 
you can set it to In Full Screen Only or Manually. Unless you find app tabs useful in Sierra, you might want to set this to Manually.

• Double-click a Window’s Title Bar to: By default, this option zooms the window, but you can instead set it to minimize the window if you 
prefer that behavior. Of course, you can just use the green and yellow buttons in the upper left of any window to zoom and minimize too, or the 
appropriate commands in the Window menu.

• Minimize Windows into Application Icon: When this checkbox is selected, minimized windows don’t show up in the document and folder 
section of the Dock, but instead disappear into their associated app. That seems less useful to us, but your mileage may vary.

• Animate Opening Applications: This checkbox controls whether or not apps bounce in the Dock while opening. Seeing when apps take longer 
than expected to launch can be instructive when troubleshooting, so we recommend leaving it on.

• Automatically Hide and Show the Dock: When this setting is enabled, the Dock disappears unless you slam the mouse pointer to the edge of 
the screen that the Dock normally occupies. It’s a handy option for small screens — think about the 11-inch MacBook Air. You can also hide and 
show the Dock with the Command-Option-D shortcut, which you can change in System Preferences > Keyboard > Shortcuts.

• Show Indicators for Open Applications: This option is on by default, and we can’t see any good reason to turn it off unless you’re offended by 
the little dots.

• Outside of the Dock preference pane, System Preferences offers a few more relevant settings:
• Icon Badges: If you see a red circle in the upper-right corner of an app’s Dock icon, that’s a badge. Badges tell you things about the app, like how 

many unread messages Mail contains or if Slack has new messages. To turn badges off or back on for any given app, open System Preferences > 
Notifications, select the app in question and set the Badge App Icon checkbox as desired.

• Dark Mode: To darken up your Dock, open System Preferences > General and select Use Dark Menu Bar and Dock.
• Parental Controls: If you have a small child using a non-administrator account that’s managed by parental controls, you can prevent that user 

from modifying the Dock. Choose System Preferences > Parental Controls > user > Other and select Prevent the Dock from Being Modified.
The Dock is easy to take for granted, but it’s a key part of your everyday Mac experience. Mastering its nuances will help you work faster, more 

comfortably, and more efficiently. That’s all we can think of to share about the Dock, but it’s entirely possible that we’ve missed something. If so, let 
us know in the comments.

Bob “Dr. Mac” LeVitus’ Tips
Keyboard Shortcuts Save You Time

Moving right along... let's take a look at another tip from Working Smarter for Mac Users... In issue 
#22, I talked about improving your typing skills; in this issue we'll look at keyboard shortcuts—which are 
another skill I recommended in the first chapter of Dr. Macintosh (1989) and still recommend to this day.

Using keyboard shortcuts is all about reducing your dependence on the mouse. Many of the things you 
do with your mouse can be done faster and easier using a keyboard shortcut.

If you’re not familiar with keyboard shortcuts, look in just about any menu in almost any application 
and you’ll see some. Take the Finder’s Edit menu, for example:
 I can’t remember the last time I opened this menu to use any of its commands. They’re so important 

and I use them so often, their keyboard shortcuts are embedded in my muscle memory. It would behoove 
you to memorize them all (or at least the four in the middle: Cut, Copy, Paste, and Select All).

 Here’s another useful example: Instead of selecting the Icon, List, Column or Cover Flow view from 
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the View menu, try using their keyboard shortcuts instead:

•  Command+1 to switch to Icon view
• Command+2 for List view
• Command+3 for Column view
• Command+4 for Cover Flow view.
  See! Isn’t that faster than taking your hand off the keyboard, grabbing the mouse, moving the cursor to the 

View menu, and then clicking an item?
  I used that menu as an example for a reason: You want to memorize those commands or at least the first three 

(unless you’re among the handful who find Cover Flow view useful).
In any case, switching views quickly make it easier to work in the Finder. For example, if I am browsing a folder 

with a lot of pictures in List view (background window below), I just press Command+1 to switch to Icon view so    
I c a n s e e 
thumbnails of the 
images (foreground 
window below).  
   Switching Finder 
v i e w s w i t h a 
keyboard shortcut 
is handy, but it’s 
merely one of the thousands of shortcuts available in 
the Finder and almost every Mac app that can save 
you oodles of time every day.
  Whenever you find yourself using a menu item 
more than a few times a day, look for a keyboard 
shortcut on its 
right. These are the 
four symbols you 
might see next to a 
letter, number, or 
punctuation mark 

in a menu: 
So, look for these shortcut symbols in menus, and memorize the ones you use most. Trust me, keyboard 

shortcuts are faster every time; you’ll save many minutes every day not reaching for the mouse/trackpad or 
moving it up to a menu item, which slows you down more than you think.  

Download these and memorize them all
I created a pair of .jpg pictures you can use to memorize some of the more useful shortcuts; download 'em, 

tape ‘em to your monitor, and then don’t remove them until your fingers automatically perform these shortcuts 
every time and you never think about reaching for the mouse.

I know it might seem weird that I’m telling you to print it, but that way you won’t need a mouse to find it. 
Plus, if you only keep it as a file on your hard drive you’ll surely forget about it.

That's all I've got for you this time. But, as always, I'll be back with more RealSoonNow™.

Yours Very Truly,

Bob “Dr. Mac” LeVitus

http://workingsmarterformacusers.us12.list-manage.com/track/click?u=f82d40eabcbc7dc8499c11296&id=2b3a1d1a9b&e=97dac8bc8b
http://workingsmarterformacusers.us12.list-manage.com/track/click?u=f82d40eabcbc7dc8499c11296&id=2b3a1d1a9b&e=97dac8bc8b
http://workingsmarterformacusers.us12.list-manage.com/track/click?u=f82d40eabcbc7dc8499c11296&id=7c68acd513&e=97dac8bc8b
http://workingsmarterformacusers.us12.list-manage.com/track/click?u=f82d40eabcbc7dc8499c11296&id=7c68acd513&e=97dac8bc8b
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New Apple Watch Stand Looks Like the 128K Mac
by Julio Ojeda-Zapata

I hadn’t planned to write about Elago’s W3 Stand, an Apple Watch charging stand in the shape of a classic 128K Macintosh. I mean, what is there 
to say? “It’s an Apple Watch charging 
stand in the shape of a classic 128K 
Macintosh.” The end.

But I realized Elago had concocted 
something brilliant when a buddy last 
week bestowed the product upon me — 
a thoughtful gesture after a recent death 
in my family — and other friends 
around a taproom table erupted with 
delight and a bit of envy.

I was even more surprised later that day when my wife spotted the accessory on my desk and went gaga over it.
You must understand a couple of things about my wife: She does not own an Apple Watch, has no interest in 

ever getting one, and has never been steeped in Apple lore. She adores her MacBook Air, but only in a utilitarian sense.
Yet, hovering and cooing over the W3, she told me she wanted one – just because. So did I when I first heard about it. 

After all, I own a nonfunctional 128K Mac, a decorative prop that has a place of honor in my home office right near my 
Power Mac G4 Cube.

The Elago W3 fits right in at Julio Geek Central. I have the $14.99 tan-colored model that approximates the color of 
the original Mac. Elago also sells a $15.99 dark-gray version, which is a strange color choice in the Mac sense, but 
matches darker-colored watches 
and straps.

The stand is a simple yet 
substantial little thing made of soft, 
sturdy rubber. It’s a mini-Mac, but 
with a vertical slot for the Apple 
Watch to slide in.

 Within the stand, there’s a 
circular cutout for Apple’s watch 
charging pad.

The W3’s cable threads downward through the accessory and out the back, mimicking the look of the 
classic Mac’s power cable.

The stand’s screen is just a cutout, so when the Apple Watch drops into place, its face becomes the actual, 
functional “Mac” display.

The Apple Watch sits on its side, which 
activates Nightstand mode and transforms the 
W3 into a nifty bedside clock with a classic-Mac 
look and feel. It even has details such as a faux 
floppy-disk slot, complete with a tiny 
paperclip-eject hole, but no Apple logo that might 
attract legal attention.

I’m using the Elago in the bedroom with a 
first-generation Apple Watch (my Series 2 watch 
charges up in my home office on the 
far-more-utilitarian Griffin WatchStand 

Apple Watch

http://www.elagostore.com/stand/w-stand/w3-stand.html
http://www.elagostore.com/stand/w-stand/w3-stand.html
http://www.elagostore.com/stand/w-stand/w3-stand/est-wt3-wh.html
http://www.elagostore.com/stand/w-stand/w3-stand/est-wt3-wh.html
http://www.elagostore.com/stand/w-stand/est-wt3-bk.html
http://www.elagostore.com/stand/w-stand/est-wt3-bk.html
https://griffintechnology.com/us/watchstand-charging-station
https://griffintechnology.com/us/watchstand-charging-station
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Powered Charging Station that also charges my iPhone). I put the original Apple Watch on my night table in Airplane mode to keep activity to a 
minimum and left it there as a permanent fixture. In fact, I am experimenting with using the Apple Watch strapless to heighten the classic-Mac 
effect:

But I suspect the mini-Mac clock will quietly migrate to my wife’s side of the bed before long. That’s fine, anything to foster marital bliss.
I hope whoever came up with this cute product at Elago got a bonus. And I wonder if sequels might be in the works — a Bondi Blue iMac 

charging stand, perhaps?

Dropbox Changes Pro to Plus, Drops Public Folders
by Josh Centers

There are a couple of changes coming to the Dropbox cloud storage service, one minor and one more significant.
First, the company is rebranding the paid Dropbox Pro tier as Dropbox Plus. No other changes are being made, as Dropbox repeats to a 

hilarious degree in its FAQ. The paid tier still costs either $9.99 per month or $99 per year and offers 1 TB of storage space. Nothing else has 
changed, it’s just called Dropbox Plus now.

Second, Dropbox is dropping its Public folder feature for Dropbox Basic (free) accounts. Dropbox has been threatening to do this since 2012 
(see “Dropbox Public Folder Leaves and Returns,” 14 July 2012), and accounts created after 4 October 2012 weren’t given a Public folder at all. 
On 15 March 2017, Dropbox will convert all Public folders on free accounts to private folders, breaking existing links. Dropbox now recommends 
using a shared folder or shared link for sharing files with others. Dropbox Plus and Dropbox Business users can continue to use the Public folder 
until 1 September 2017.

Similarly, Dropbox removed the capability to render HTML files stored in Public folders from Dropbox Basic accounts last year (see “Dropbox 
to Discontinue HTML Rendering, Breaking Hosted Sites,” 7 September 2016). That capability will also disappear for Dropbox Plus and 
Dropbox Business users on 1 September 2017. Many users took advantage of this feature for free Web site hosting, and Dropbox apparently didn’t 
like that.

It may seem as though Dropbox is just removing features and not adding new ones, but that’s not entirely the case — the company added a few 
new things last year, as “Take Control of Dropbox” author Joe Kissell outlined in “Catch Up with the Latest Dropbox Features” (3 March 
2016). Although it’s annoying to lose the Public folder and its HTML rendering capability, Dropbox remains useful because it’s integrated so well 
into the Mac and iOS experience, and it just works.

How to Restore Data from iCloud
by Michael E. Cohen 

“What is truth?” This question has bedeviled philosophers and theologians for centuries, but in an age of distributed digital data storage you also 
need to know the answer to the question, “Where is truth?” This is not a philosophical question but a practical one: if you have a bunch of devices, all 
with copies of your personal information — your contacts, calendars, and so forth — where do you find the one true copy of your data, the one on 
which all of your devices can rely?

In the context of data shared among multiple devices, “the truth” is a technical term that refers to where devices with conflicting data go to get 
their conflicts resolved. If you’ve always wondered what Steve Jobs meant by “The truth is on the cloud,” now you know. And if, like me, you store 
your contacts, calendars, reminders, and other stuff in iCloud, iCloud is where you go to resolve data discrepancies. That’s where the truth lies. What 
you have on your devices is not the truth, but merely a reflection of it, copied from iCloud. Even if you could find the files on your devices that 
contain your information, you couldn’t fix any problems there by whipping out some sophisticated 
file fiddling tool and twiddling bits, because that is not where the truth lies.

iCloud, however, much like real clouds, is notoriously opaque. It’s hard to see just what you have 
stored in it. Nonetheless, Apple has made it easy to fix some truth-related issues in iCloud, and you 
can do it with a readily accessible tool: a Web browser on any Mac or PC. With it, you can revert to 
backups of your contacts, calendars, reminders, and shared bookmarks, and even restore files deleted 
from your iCloud Drive.

The first step is to go to icloud.com in your browser and log in with your Apple ID and password.
Once you sign in, click the Settings icon on the launchpad page.

The Internet

https://griffintechnology.com/us/watchstand-charging-station
https://griffintechnology.com/us/watchstand-charging-station
https://www.dropbox.com/help/6908
https://www.dropbox.com/help/6908
https://www.dropbox.com/en/help/16
https://www.dropbox.com/en/help/16
http://tidbits.com/article/13117
http://tidbits.com/article/13117
https://www.dropbox.com/help/274
https://www.dropbox.com/help/274
http://tidbits.com/article/16735
http://tidbits.com/article/16735
http://tidbits.com/article/16735
http://tidbits.com/article/16735
http://tid.bl.it/tco-dropbox-tidbits
http://tid.bl.it/tco-dropbox-tidbits
http://tidbits.com/article/16298
http://tidbits.com/article/16298
https://en.wikipedia.org/wiki/Single_source_of_truth
https://en.wikipedia.org/wiki/Single_source_of_truth
http://www.theverge.com/2011/06/13/icloud-apple-strategy-flaw
http://www.theverge.com/2011/06/13/icloud-apple-strategy-flaw
https://www.icloud.com/
https://www.icloud.com/


13
That brings you to the iCloud Settings page, which contains 

information about your iCloud account, a list of the devices that are signed 
into your iCloud account, and, way down at the bottom of the page, an 
Advanced section that provides some data restoration capabilities.

Here’s what you can fix, along with some caveats where appropriate:
• Files: When you remove a file from iCloud Drive, whether you do it by 

dragging it out of iCloud Drive on your Mac or by deleting it from 

within an app on your Mac or in iOS, iCloud saves the file for thirty 
days before it goes away for good, much like the way deleted photos 
are stored in the Recently Deleted album in the Photos app. Select 

the files you wish to put back into their respective iCloud Drive folders and click Restore to have them reappear in iCloud Drive.
• Contacts: iCloud keeps track of when you make changes to Contacts 

and stores an archive of that data from the day before. iCloud retains 
these archives for about a month. If your contacts get messed up or 
muddled on your devices, you can restore them from an earlier day’s 
version: click Restore to the right of the archive you wish to restore. Note 
that restoring an archive restores the contacts on all of your devices 
(remember, the truth is in iCloud, not on your devices). An archive of 
the contacts you just replaced is also stored in iCloud, so you can revert 
to it if you desire.
• Calendar Events and Reminders: Like Contacts, iCloud notices 
when you make changes to your calendar events and reminders and 

stores an archive of your Calendar and Reminder data as they were on 
that day before you made any modifications. Also like Contacts, iCloud 
retains about a month’s worth of Calendar and Reminders archives. 
Select Restore by the entry for the Calendar and Reminders archive that 
you want to restore; doing so replaces that information on all of your 
iCloud-connected devices. Like Contacts, your replaced calendar and 
reminder information is then stored in an archive so you can revert to it if 
you want. Keep in mind, however, that calendars and reminders can be 
shared with others, so restoring from an archive has a couple of side 

effects: any shared calendars and reminders will have to be shared again, 
and any pending calendar event invitations you have sent out are 
removed and new invitations issued in their place.
• Bookmarks: iCloud makes it easy to share the same Safari 
bookmarks and reading lists among all your devices, and it stores 
changes to those on a daily basis when you modify them on any device. 
As with Contacts, you merely need to click Restore by the bookmark 
archive you want to replace the bookmarks and reading lists on your 
iCloud devices (you have the previous month’s worth of archives to pick 
from). And, similar to Contacts and Calendars, the replaced bookmarks 

https://support.apple.com/kb/PH21313
https://support.apple.com/kb/PH21313
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and reading lists are archived so you can restore those if necessary.
For old-time Mac users who like to see, touch, and manipulate the data on their computers, Apple’s move to managed data and cloud storage can 

be frustrating. However, Apple has at least provided some easy-to-use tools that give users back a little control over their stuff. The level of control 
may not be complete, but it’s far better than nothing.

ExtraBITS
Bare Bones Drops TextWrangler for BBEdit’s “Free Forever” Demo -- Bare Bones Software is sunsetting its free TextWrangler text editor, 
encouraging TextWrangler users to move over to the non-expiring demo mode of BBEdit, which offers all the same features and more, including 
ponies.

Dropbox Changes Pro to Plus, Drops Public Folders -- Dropbox is making a couple of changes to its file-storage service: a rebranding of 
Dropbox Pro and completely dropping the public folder for Dropbox Basic (free) users.

Apple’s Grip on the Classroom Slipping -- Apple has long had a strong position in the education market, but the New York Times reports that 
the company is losing ground to Google, with Apple’s iPads and Mac laptops now ranking third behind inexpensive laptops running Google’s 
Chrome OS or Microsoft’s Windows. Unfortunately, for those familiar with the education world, Google’s rise isn’t all that surprising, given the 
advantages Chromebooks have over iPads: they’re cheap, they have keyboards, there’s not much on them that students can mess up, and they’re 
backed up by services such as Google Classroom.

YouTube TV to Offer Another Alternative for Cord Cutters -- Google will soon be competing with the likes of Sling TV, PlayStation Vue, and 
DirecTV Now. Set to debut within a few months in a new standalone app, the $35-per-month YouTube TV service will feature about three dozen 
channels, including ABC, CBS, NBC, and Fox, as well as cable stalwarts like ESPN and Fox News. Google says the service will be designed 
primarily for mobile but will also work with computers and its Chromecast streaming devices. It’s slated to have a cloud-based DVR with unlimited 
storage and a Google AI-powered recommendation system. We’re guessing YouTube TV will be limited to U.S. viewers, but no details on 
international possibilities were mentioned.

Apple Kicks Provisioning Profile Expirations Down the Road -- Provisioning profiles have been expiring recently, causing popular apps like 
1Password and PDFpen to stop working suddenly. Apple has “solved” this problem by making it so that Developer ID provisioning profiles 
generated after 22 February 2017 will be valid for a whopping 18 years, regardless of the expiration date of the associated certificate! That puts the 
problem off for so long that only institutions and individuals trying to keep historical systems functional will be likely to suffer. After all, some of us 
still have decades-old Macs that can run software of the 1990s without difficulty.

A Prairie HomeKit Companion: Fine Tuning with the Other “Home” App -- Apple’s Home app is easy to use, but an older app with the same 
name gives you more control over your HomeKit home automation.

Five Keyboard Cases for the 9.7-inch iPad Pro -- The iPad Pro is a decent laptop stand-in for productivity on the go, but it can’t realize its full 
potential without a physical keyboard. Julio Ojeda-Zapata tested the latest keyboard accessories for the 9.7-inch iPad Pro. They’re all good, though 
none is perfect.

Keyboard Problems Reported in the 2016 MacBook Pro -- Some owners of the 2016 MacBook Pro are reporting problems with the laptop’s 
built-in keyboard. Issues include non-functional keys, keys double-entering characters, a high-pitched clicking when pressing keys, and keys with a 
non-uniform feel. Most of the complaints have focused on the 15-inch Touch Bar model of the MacBook Pro, but a few have been made about the 
13-inch models as well. Apple is reportedly fixing or replacing affected units.

Apple Park to Open in April 2017 -- Apple’s new “spaceship” campus now has a name — Apple Park — and employees will begin relocating in 
April, a process that will take over six months. Construction of other buildings and parklands around the campus will continue throughout the 
summer. The 1000-seat theater at Apple Park will be named the Steve Jobs Theater, after Apple’s late CEO.

Reuse governed by Creative Commons license. TidBITS has offered years of thoughtful commentary on Apple and Internet topics. For free 
email subscriptions and access to the entire TidBITS archive, visit www.tidbits.com.
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15

AKVIS Sketch 19
by L. Davenport

Akvis Sketch can be used to convert photos into black and white or colored sketch drawings or even watercolor paintings. There are two 
photo-to-sketch conversion styles: Classic and Artistic - both can be used to create a wide variety of pencil drawings.

Classic style
The Classic style lets 

you create color and 
black-and-white drawings 
w i th we l l -de f ined 
contour lines (Figure 3). 
The converted image 
looks like it was created 
with contour lines and 
hatching. This would be 
good for pictures where 
you want more detail, 
such as with architectural  
or technical illustrations.

Besides creating a 
black-and-white picture, 
you can also create 
colored sketch pictures by 
setting the degree of color 
that still shows through 
f rom the or ig ina l 
photograph (Figure #1 & 
2). 

The Akvis Sketch 
parameters give you 
complete control over the angle and thickness of your hatching strokes along with the minimum and maximum length of the strokes.

The “Edges” parameters let you set the Edge strength. For example the lower parameter levels create fewer edges so the level of detail decreases. 
Conversely, the higher values draws the edges with more detail (Figure 6).

The “Effects” parameters let you convert your photo to a watercolor or charcoal drawing. As you move the Watercolor slider to a higher value, the 
strokes get blurred and the contrast and detail gets weaker, imitating drawing on wet paper. If you combine the Watercolor and Coloration 
parameters, you will end up with a colorful watercolor drawing. The “Smudging” effect lets you smear the midtone hatching areas without affecting 
the contour lines of the drawing. This is similar to what artists do when they rub a stump tool or their finger over their drawing to smooth out their 
pencil strokes.

The “Contrast” parameter increases the difference between the highlights and shadows and the “Noise” parameter adds noise to the image which 
in turn increases the shading effect.

Artistic style
The Artistic Style parameters are designed to create expressive drawings that look like handmade drawings of a real artist. Using this style, you can 

create both a quick sketch or a nice complex shaded pencil drawing.
When you turn on the “Original Colors” option, Akvis Sketch uses the colors of the original photo. By contrast, if you disable the Original Colors 

Reviews

(Figure 1) This is AKVIS Sketch’s main work window. It is currently showing a color sketched image that is 
surrounded with a wood frame. To the right it shows various frame styles that are available. At the bottom of the 
window are thumbnails showing the various steps taken to modify this photograph.
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option,  it will turn to a black-and-white image. You can also change your sketch to blue and white, red and white, etc. to give it a unique look.
As with the Classic Style, the Artistic Style also lets you set the angle, thickness of your stroke, and the maximum and minimum length of each 

stroke. But the Artistic style also let you set the Uniformity, Curvature, Hatching Intensity, and Crosshatching (versus drawing all in one direction).
The AKVIS Sketch “Home Deluxe” and “Business” licenses have a Timeline at the bottom of the main window. This lets you see the progression 

of the conversion of your photo into a pencil drawing (Figure 1). If  it turns out that you like the third image better than the final, etc., you can click 
on its thumbnail to step back in the process and save it as your final image.

There are two buttons at the top of the AKVIS Sketch window called: Express and Advanced. The Express button/mode streamlines the 
controls/parameters to the bare minimum, where as, the Advanced mode 
shows all of the controls and parameters. So if you're in a hurry, you can 
choose the Express mode to do a quick sketch. But if you want more 
controls so you can to find tune your sketch, you will want the Advanced 
mode.

AKVIS Sketch’s Background Effects can be used to process the converted 
image further e.g. it can blend the original photo on the drawing, blur some 
parts of your image, or add a motion blur. It also gives you blue and red 
pencil tools that you can use to define which areas will be converted to a 
drawing and which will not. For example, I used the red pencil in the 
Figure 5 image to preserve the face of the Egyptian queen. Afterward, I used 
the blue pencil to specify the areas that I did want changed to a sketch 
drawing. 

When the conversion process is complete and you are satisfied with the 

(Figure 2) I created this image using Photoshop Elements and the AKVIS Sketch plug-in. I followed one of AKVIS’ tutorials that 
makes your final image look like it has a postcard lying over a  color pencil drawing.

(Figure 3) The Classic Style has well defined lines

http://akvis.com/en/sketch-tutorial/examples/photo-on-sketch.php
http://akvis.com/en/sketch-tutorial/examples/photo-on-sketch.php


final image, you can add a frame to give your image a finished 
look. AKVIS Sketch comes with five different types of 
frames: Classic frame, Pattern frame, Strokes, Vignette, and 
Passe-Partout.
• Classic frame: this lets you surround your image with a 

typical square frame just like frames that surround a 
painting (Figure 1).

• Pattern frames are small picts that you can surround your 
image with. There is a Library that includes many texture 
samples and patterns 
that you can use, such 
as flowers, butterflies, 
leaves, holiday items, 
etc. 

• The Strokes frames are 
long straight lines that 
are drawn around the 
edge of your image. 
You can set the stroke 
l i n e ’ s c o l o r , 
transparency, intensity, 
size, stroke number, 
width, length, and 
randomness. Each 
gives you a unique look 
(Figure 5).

• The Vignette effect lets 
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(Figure 4) The original photograph is in the upper left-hand corner. The remaining seven images were created using seven (of the 
many available) presets. Notice how you can get a totally different finished product depending on which preset you choose to use.

(Figure 5) I did two additional things to this image: First, I wanted the Egyptian queen’s face to be untouched from 
the sketching patterns to preserve her beauty. So I used the “Sketch & Photo’s” red pencil to draw a circle around her 
face and neck (telling AKVIS Sketch to leave that area untouched). After that, I added a white “Stroke” frame around 
the image. BTW: The image is intentionally dark so you can easily see the Stroke frame in such a small image.
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you lighten or darken the edges of your image, thus creating a 
retro styled image (Figure 7).

• The Passe-Partout effect lets you surround your image in a 
mat (basically it surrounds your image with a beveled white 
cardboard frame).
AKVIS Sketch has tools that let you add Text or Watermarks 

to your drawing. So you can add a signature, greeting, logo, or a 
watermark to protect your image.

If you want, you can add a texture to the surface of your 
image, thus imitating drawing on a canvas, corrugated paper, 
brick wall, etc. 

If you are a budding graphic novelist (comic-books), you can 
use AKVIS Sketch to convert your photos into comic-book 
illustrations (Figure 6). This is especially handy for those who 
can’t draw. They can take photos of an action figure (or in my 
case I saved a rendered image of my 3D robot) and convert 
them. This way you can pose them (in real-life or digitally in a 
3D program) and slowly create the artwork for your comic-book.

AKVIS Sketch comes with many presets that help you get started modifying your 
photos. But if you can’t find a preset that you like, you can create your own and 
save it for later use.

If you have a lot of photos that were taken under the same conditions with 
identical camera settings, you can use the Batch Processing option to process the 
whole group at one time.

If my review has piqued your interest but you'd like to see more, please go to 
AKVIS’ Examples web page to see around 68 images that have been converted 
using AKVIS Sketch (it also shows you the steps that were used to create the 
finished image). You can also go to AKVIS’ YouTube web page and watch the 
Sketch videos or click on the following link if you would like to see a short B & W 
animation created using AKVIS Sketch. 

AKVIS Sketch comes as a standalone program or as a plug-in that you can use in 
a photo editor such as Photoshop, Photoshop Elements, Corel Paint Shop Pro, Corel Painter, GIMP, etc. I suggest you go to AKVIS’ 
Compatibility webpage to see the list of compatible editors and to get the exact versions that it is compatible with before your buy the program.  

The Skinny 
Evaluation: I am quite impressed with the sketches that AKVIS Sketch can create. I like that not only can it create sketches, but it also has frames 

that you can apply to give your sketches a professional finished look. I like being able to use the AKVIS Sketch plug-in version (as was used in 
Figure 2). Since the image is already inside Photoshop Elements, I was able to easily use Photoshop Element’s tools to create a drop shadow 
and a border for the postcard.

Requires:  
           Operating System: Mac OS X 10.7-10.12 (Sierra), 32 or 64 bit

Minimum  hardware requirement : Intel, 1 Gb RAM, 100 Mb free hard drive space
Recommended hardware requirement: Intel, 4 Gb RAM, 2 Gb free hard drive space
A Compatible Image Editor (if you purchased the plug-in)

Company: AKVIS 
Price: 
 Home (non-commercial license): Standalone OR plug-in $72
 Home Deluxe (non-commercial license): Standalone & Plug-in $89
 Business (commercial license): Standalone & Plug-in $154

Academic license for Home or Home Deluxe: 30% off discount (proof of enrollment or employment in an educational institution is required)
Available 10 day Trial copy
•

(Figure 7) The Vignette effect lets you lighten or darken 
(in varying amounts) the edges of your image.

(Figure 6) You can set the amount of your photo’s original color that will 
show in the final image. You can also increase the “Edges” parameters to add 
an outline to your image, thus making it look like a comic-book illustration. 

http://akvis.com/en/sketch-tutorial/examples/index.php
http://akvis.com/en/sketch-tutorial/examples/index.php
https://www.youtube.com/playlist?list=PLSY7e-J1kpryAfYXdN3ShtIcr1KhxixUE
https://www.youtube.com/playlist?list=PLSY7e-J1kpryAfYXdN3ShtIcr1KhxixUE
https://www.youtube.com/watch?v=00csaNNt34Q&feature=plcp
https://www.youtube.com/watch?v=00csaNNt34Q&feature=plcp
https://www.youtube.com/watch?v=00csaNNt34Q&feature=plcp
https://www.youtube.com/watch?v=00csaNNt34Q&feature=plcp
http://akvis.com/en/compatibility-software.php
http://akvis.com/en/compatibility-software.php
http://akvis.com/en/index.php
http://akvis.com/en/index.php
http://akvis.com/en/download-macintosh-software.php
http://akvis.com/en/download-macintosh-software.php
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HOW TO FIND US
General meeting:
SMMUG General Meetings are held on the SECOND Monday of 
each month at Fire Station 14 located at 1875 Dublin Blvd (at the 
intersection of North Academy and Dublin). 

Directions:
From Academy, go east on Dublin and then turn right on 
the very first street. There is parking on the west and south 
sides of the Fire Station (with additional parking located to 
the north and further west of the Fire Station). The entrance 
is on the west side of the building.

Smoking is not permitted on the premises. 

Sig meeting:
The SIG Meetings are held on the SECOND Saturday of each month at Fire Station #18’s meeting room - located at: 6830 Hadler View 
[the fire station is behind Walgreens]. 

Directions:
#1) Take I-25 to Garden of the Gods Rd (head west), turn right on Centennial, left on Flying W Ranch Rd., right on Hadler View.
#2) (This route is bumpier and probably not the best for winter travel) Take I-25 to E. Woodman/W. Rockrimmon Blvd., turn right on Vindicator 
(at the Safeway intersection), and then right on Hadler View.
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Name
 Street Address

 City/State/ZIP
 Home Telephone

 E-mail Address
Have you previously been a member of SMMUG?
How did you learn about SMMUG?

Make your check payable to:  SMMUG  
Then mail or give this form and your check to:

SMMUG, Inc. 
Skip Mundy, Treasurer   
PO Box 62741 
Colorado Springs, CO   80962 

Please make an online account for me.
User Name _______________

Don’t make an online account for me. 
I do not want one or I already have 

Business Telephone 

About Us

The Silicon Mountain Macintosh User Group, Inc. (a nonprofit educational corporation) was formed in Colorado Springs, 
Colorado in 1985, and is one of the oldest Macintosh User Groups in the United States. SMMUG, Inc. is dedicated to helping 
members enjoy and learn about their Macintosh computer, iPhone and iPad devices.

Club membership is open to everyone and you are cordially invited to visit our free monthly General Meeting on the second 
Monday of each month, at 7:00 PM. For those new to the Macintosh, we have a Question & Answer session at 6:00 PM, where 
our collective expertise can help answer your questions. 

All members receive a monthly newsletter, published on our web site, see great reviews of software and hardware, or can 
participate in the monthly door prize drawing. Each member gets one vote during annual Officer Elections. No corporate 
memberships are granted.

Our officers are volunteers and receive no pay. All funds raised are used for the cost of operating the club and its meetings.

Membership Application Form
Membership entitles you to access to our online forums, participation in prize drawings, and access to the 
bargains in the members area of the SMMUG website at www. smmug.org. SMMUG renewal membership dues 
($30) apply to the calendar year and are paid each December for the following year. Use the following table for 
NEW MEMBERSHIP ONLY:

 JAN 1 to MAR 31 - $30.00  APR 1 to JUN 30 - $20.00
 JUL 1 to SEPT 30 - $15.00  OCT 1 to DEC 31 - $10.00

Please Print Clearly!     Today’s Date 

http://www.smmug.org
http://www.smmug.org

